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1. Warnings 
 
ABB SACE S.p.A. responsibility towards the user necessarily presumes that the program has been used in a 
professionally correct manner and that the user has followed all the given precautions/instructions. 
Even in the case of program defects which have been detected and verified, ABB SACE S.p.A. shall only be 
responsible for repairing the program in a reasonable length of time. 
ABB SACE S.p.A declines all responsibility for either direct or indirect damages, however caused, to the user or third 
parties by use or non-use or late availability of the program, magnetic support or documentation supplied. 
The user must: 
- check the use of the program supplied by ABB SACE S.p.A. and the reliability and accuracy of the data entered, and 
also that the data entered fully corresponds with and is consistent with the printed results; 
- take all necessary precautions to safeguard and preserve data and to  allow him to reconstruct data using his own 
means should the data be lost or destroyed due to an error in handling or entering data and/or an error in using the 
program, or even an operational defect of the program and/or processor used; 
- ensure that the program is only used by professionally and technically qualified personnel able to use it correctly. 
The user must follow the instructions and notes given and take all the precautions recommended at all times. 
ABB SACE S.p.A declines all responsibility if the user does not follow the instructions for operation and use indicated. 
ABB SACE S.p.A. declines all responsibility for any damages due to destruction of data files or other occurrences 
caused by not having followed the instructions and precautions indicated, by not having used the program correctly or 
due to an operational defect of the computer used, whatever the cause of this operational defect may be. 
ABB SACE S.p.A. declines all responsibility for mistakes by the user concerning the use of the program and any 
mistakes and/or inaccuracies contained in the data and/or data combinations entered. 
ABB SACE S.p.A. reserves the right to modify and/or update the program and relevant instructions, at any such time 
that it is deemed necessary or opportune, in the light of new provisions of law and technological, management or 
operational developments. 
 
Conditions of use: 
- The program is protected by Copyright. 
- No unauthorized copies of the program and relevant documentation are permitted. 
- Changing, adapting, re-designing or creating applications based on the program itself, on the files or documentation 
supplied is forbidden. 
- ABB SACE S.p.A. reserves the right to take legal action to protect its interests. 
- The software is not for sale and is distributed for promotional purposes only. 
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2. Introduction 
 
The thermal calculation module makes it possible to evaluate the thermal behaviour of ABB boards and – if desired – to 
dimension the fans and air-conditioning units to be installed in the board. It can also be used on sets of boards obtained 
by installing several units side by side. 
 
 

3. Reference standards 
 
The algorithms used by the software are as described in Standard IEC 60890, hereinafter the “Reference Standard”; if 
the use of air-conditioning or fans is specified (a situation not considered in the Reference Standard), the program still 
uses computation algorithms that are compatible with Standard EN 60439 on low-voltage boards. 
 
 

3.1. Range of applicability of the results  
 The Reference Standard specifies very clearly the applicability of the calculation algorithms: 

The proposed method makes it possible to determine the overtemperatures, or the air 
temperatures, inside the enclosure, but is unable to determine the temperatures of individual 
equipment, devices and cables contained in it 
The temperatures of the air inside the board is the same as that of the ambient air outside the 
enclosure plus the overtemperatures of the air inside the board due to the power dissipated by 
the devices installed (when the air-conditioning is used) 
Unless otherwise specified, the temperature of ambient air outside the PTTA corresponds to 
the temperature specified for PTTA units for indoor installation: 35°C (average value over 24 
hours). If the temperature of the ambient air outside the PTTA at the utilisation site exceeds 
35 °C, this higher temperatures is regarded as the temperature of the ambient air in the PTTA 
The distribution of dissipated power inside the enclosure is basically even; the devices are 
installed in the board so as not to hinder the circulation of the air, other than to a minimal 
extent 
The equipment installed is designed for DC or AC, up to and including 60 Hz, with the sum 
of supply circuit currents not exceeding 3150A 
The cables carrying high currents and the structural parts are arranged so as to ensure that 
losses due to eddy current will be negligible 
In enclosures with ventilation openings, the cross-section of the air outlet holes is at least 1.1 
times as big as the cross-section of the air inlet openings  
Any of the compartments of the PTTA will not contain more than three horizontal frames 
When enclosures with external ventilation openings are divided into cells, the area of the 
ventilation openings in each internal horizontal frame must cover at least 50% the horizontal 
section of the cell. 

 

 

��������

 The results of the calculation process are reliable provided that the conditions defined in the 
Reference Standards are complied with. Otherwise, the algorithms employed might fail to 
provide a correct interpretation of the physical reality of the temperatures inside the board. 
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4. Menu commands 
 
Using the menu commands, the management of the ABB thermal calculation module is user-friendly and all the relative 
calculation processes can be performed easily. 
 

4.1. File menus 
 The “File” menu contains the following commands: 

 
New > creates a new computation file  
Open... > opens a previously saved thermal dimensioning file (extension *.tra)  
Save > Saves the calculation underway; it creates a file in binary format with extension *.tra; 
at the same time, a text file (*.txt) is also created to facilitate the consultation of the results 
obtained  
Save as… > Saves the thermal dimensioning project underway with a name other than the 
current one  
Data > Enables the user to enter, or change, the data in the project heading (customer, plant, 
project, board …) 
Export drawing > Exports the board overtemperatures curve in *.wmf format for pasting in 
other applications  
Print… > Prints the data and the results of the thermal calculations 
Exit > Closes the thermal calculation module 

 

4.2. Help menu  
 The Help menu gives access to the help file, the information about the product version and its 

utilisation conditions. 
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5. Module for the determination of overtemperatures 
 
To use the thermal calculation module, first of all you must specify the “Cooling system” that you intend to adopt by 
selecting one of the three options listed. The next item to be selected is the unknown quantity that you want to 
determine by selecting the desired “Quantity to be determined” option. Choosing an unknown converts the other options 
into data that have to be defined before starting the dimensioning process. 
 
 Cooling system Target of calculation 
 Natural ventilation Temperature profile 

Losable power 
 

Forced ventilation 
Temperature profile 
Losable power 
Fan capacity 

 
Air-conditioning 

Temperature profile 
Losable power  
Conditioning power 

 
 

 
(Figure 1) – First window of the tool for the calculation of overtemperatures 
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 The central part of the interface is dedicated to the definition of the properties of the board, 

i.e., the input data relating to its construction characteristics; in particular, the user must 
specify: 

 Type of installation 
Regardless of the calculation method adopted, the user can choose from among the 
installation modalities defined in the Reference Standard and listed below. 
 

 

 

Separate enclosure, detached on all sides 

 

 

Separate enclosure for wall-mounting 

 

 

First or last enclosure, detached type 

 

 

First or last enclosure, for wall-mounting  

 

 

Central enclosure, detached type 

 

 

Central enclosure, wall-mounting type 

 

 

Covered on 2 sides and top surface, for wall mounting 

  
Dimensions of the enclosure  
 
Horizontal frames  
(See 3.1  (Range of applicability of the results) 
 

 Moreover, in the case of natural ventilation, the user must also specify: 
The area of the ventilation grids 
 
In the case of forced ventilation or air-conditioning, when the values are not given as outputs 
from the calculation, the user must specify: 
Fan capacity, or 
Air-conditioning power 
You can enter the air-conditioning power form the keyboard or use a calculator shaped button 
to select one of the values offered by ABB. 
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 The zone dedicated to the “Effective cooling area (Ae)” displays some partial results of the 

calculation, i.e., some parameters determined according to the Reference Standard, which 
help the user understand the calculation performed; obviously, this requires a good 
knowledge of the calculation method employed (this is recommended, but is totally at the 
discretion of the user). 

  
 Click “Next>” to access the second and last page of the calculation. 
 
 

 
(Figure 2) – Second window of the tool for the calculation of overtemperatures 

 
 The first line under the menu recalls the cooling system and the calculation target selected in 

the first screen. 
 
The box “Power losses” enables the user to define the powers dissipated and the demand 
factor, i.e., the main factors contributing to heating the board; in particular, as far as 
dissipated powers are concerned, it is possible to define the contribution of the devices 
installed (“Devices rated power losses”), the contribution due to bars and cables 
(“Conductors power losses”) plus a generic contribution available to the user (Extra power 
losses). 
The calculator to the right of the demand factor opens a window with the preferential values 
that can be assigned to this factor as a function of the number of main circuits present in the 
board. 
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��������

 The software performs the calculation in real time and updates whenever an input value is 
changed. This means there is no need to use a specific command to perform the calculation 
and consistency between the data is always ensured; the results are displayed on screen for 
the user to see and can be printed out at any time. 

 
 All the results of the calculation are grouped in the “Results” box. 
 The “Power [W]” box provides an overview of the powers dissipated in the board and, 

depending on the cooling system adopted, the power removed by the fan or the air-
conditioning system. 
In this manner it is easy to see how the software determines the value of “Total power losses” 
which is then used to calculate the internal overtemperatures with the method specified in the 
Reference Standard. 

 
  
 The overtemperatures vs. enclosure height curve (available only in the case of natural 

ventilation) makes it possible to determine the temperatures at the points where the devices 
are installed. 
It is sufficient to know the installation height of the device to be checked, read the 
overtemperature value on the abscissas and add the “Ambient temperature” value to obtain 
the internal temperature of the board at the desired height. 

 

 
(Figure 3) – Graphic of overtemperatures inside the enclosure 

 

 
�	
��
�
�����
	���
��

 You can either print the calculation report, or  
Use the Export drawing command in the File menu, or  
Move the mouse pointer over the graphic, right click and select “Export drawing”: now 
you can paste the graphic in any other application! 

 



 

 

Overtemperature calculation tool – User Guide – Page 10 

 
 The value assumed by the calculation target selected in the first page appears in the bottom 

part of the screen. 
The table below provides an overview of the parameters calculated by the software 
depending on type of cooling system and the calculation target selected by the user. 

 
 Cooling system Target of 

calculation 
Results 

Temperature 
profile 

Temperatures at the top of the enclosure 
Overtemperature at the middle of the enclosure 
Overtemperature at the top of the enclosure 

 

Natural ventilation 

Losable power 

Maximum losable power 
Maximum losable power still available (residual) 
Overtemperature at the middle of the enclosure 
Overtemperatures at the top of the enclosure 

Temperature 
profile 

Temperatures at the top of the enclosure 
Overtemperature at the middle of the enclosure 
Overtemperature at the top of the enclosure 

Losable power 

Maximum losable power 
Maximum losable power still available (residual) 
Overtemperature at the middle of the enclosure 
Overtemperatures at the top of the enclosure 

 

Forced ventilation 

Fan capacity 

Power losses extracted by the fan  
Fan capacity 
Overtemperature at the middle of the enclosure 
Overtemperatures at the top of the enclosure 

Temperature 
profile 

Average temperature inside the enclosure 

Losable power Maximum losable power 
Maximum losable power still available (residual) 

 

Air-conditioning 

Conditioning 
power 

Power losses extracted by the air-conditioning  
Air-conditioning power 
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6. Calculation algorithms and formulas: basics  
 
As mentioned above, if natural ventilation is used, the calculation method adopted is that of the Reference Standard. In 
the presence of air-conditioning or fans (situations not envisaged by the Reference Standard), the calculation algorithms 
used are still compatible with Standard EN 60439. 
Some important details of the calculation process are given below. 
 

6.1. Determination of Ae 
 The determination of Ae (Effective cooling area that determines the heat exchange between 

the enclosure and the external environment) is generalised to the entire ABB thermal 
calculation module and is applied both in the case of natural ventilation and in the case of 
forced ventilation or air-conditioning.  
 
For further details on the calculation process see the Reference Standard. 

 

6.2. Forced ventilation 
 In the case of forced ventilation (a situation not considered by the Reference Standard), the 

thermal power extracted by the fan is determined with this formula: 

P = Q ���� (Te - Ti ) / fx 
where: 

P = Power to be extracted [W] 
Q = Fan capacity [m3/h] 
fx = Thermal exchange coefficient [m3 °C/Wh] 
Te = Ambient temperatures [°C] 
Ti = Temperatures inside the enclosure [°C] (Te <Ti) 

 
The table below gives the values of fx as a function of altitude above sea level (from the 
qualitative standpoint, air density decreases with increasing altitude and its capacity to 
subtract heat decreases accordingly). 

  
 Altitude above sea level of installation site [m] fx [m3 °C/Wh] 
 0 – 100 3.1 
 100 – 250 3.2 
 250 – 500 3.3 
 500 – 750 3.4 
 750 – 1000 3.5 
 Then, the power extracted by the fan is subtracted from the power dissipated in the enclosure 

and the calculation is performed according to the Reference Standard without natural 
ventilation openings. 
For further calculation details, see the Reference Standard. 

 

6.3. Air-conditioning 
 Air-conditioning is not taken into account in the Reference Standard; in this case, the 

software uses the formulas given below. 

As a rule, the use of air-conditioning shows that ambient temperature is greater than the 
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interior temperature of the enclosure: in this case, the contribution of the thermal power that 
is transmitted through the surface of the board must be summed to the power losses due to 
the devices, the cables, etc.  

This contribution is obtained from the following formula:  

Pa = Kf ���� Ae ���� (Te - Ti) 
where  

Pa = Power entering the enclosure through the environment [W] 
Ae = Effective cooling area [m2] 
Te = External temperature [°C] 
Ti = Interior temperature [°C] 
Kf = Thermal exchange coefficient (depending on the board wall material; in our case 
it is Kf = 5.5 [W / m2 °C]) 

 

The air-conditioning power to be installed is given by this formula: 

Pc = Pt /Kx 
where 

Pc = Air-conditioning power to be installed [W] 
Kx = Cooling efficiency of the air-conditioning  
Pt = Total power loss in the board (Pa included) [W] 

 

The Kx factor, which is a function of the ambient temperature and the temperature you want 
to obtain inside the board, is given by the manufacturer of the air-conditioning system. For 
ABB air-conditioners, Kx is obtained from the diagram shown below (only ambient 
temperatures in the 20 - 55°C range and interior temperatures in the 20 - 45°C range can be 
considered). 

The software adds the power Pa to the power dissipated inside the board, subtracts the power 
removed by the air-conditioning and then performs the calculation according to the Reference 
Standard without natural ventilation openings. 
For further details on the calculation process, see the Reference Standard. 
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(Figure 4) – Kx factor determination diagram 

 
 

7. Printouts 
 
The thermal calculation module offers ad hoc report forms as a function of the “Cooling system” adopted; printed 
reports contain all the parameters needed for the thermal dimensioning calculation: both the input data (dimensions of 
the board, installation modalities…) and the results (temperatures, power losses…). 
 
The items – Customer, Plant, Project/Quotation, Board, Designer and Date – that appear in the heading of the printed 
documents can be added to the calculation report through the main menu Data command.  
If they are not associated with a numerical value, the items “Total power losses”, “Losable power” and “Losable power 
still available (residual)” will not be taken into account. 
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